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คําอธิบายรายวิชา
   ศึกษาและปฏิบัติเกี่ยวกบัหลกัการ ประเภทและคุณลักษณะของ
ภาพกราฟก หลักการของภาพกราฟกแบบ Vector และ Bitmap
การสราง แกไขและตกแตงภาพกราฟกดวยโปรแกรมสําเรจ็รูป
ภาพกราฟก หลักการของภาพกราฟกแบบ Vector และ Bitmap
การสราง แกไขและตกแตงภาพกราฟกดวยโปรแกรมสําเรจ็รูป
กราฟก และการประยกุตใชโปรแกรมกราฟกในงานอาชพี



จุดประสงคการเรียนรู
1. เขาใจเกีย่วกับหลกัการ ประเภทและคุณลักษณะของภาพกราฟก
2. สามารถสราง แกไข และตกแตงภาพโดยใชโปรแกรมสําเร็จรปู
กราฟก
2. สามารถสราง แกไข และตกแตงภาพโดยใชโปรแกรมสําเร็จรปู
กราฟก
3. สามารถประยกุตใชโปรแกรมกราฟกในงานอาชีพ
4. มีเจตคติและกิจนิสัยที่ดีในการปฏบิัติงานคอมพิวเตอรดวยความ
ละเอียดรอบคอบและถูกตอง



สมรรถนะการเรียนรู
1. แสดงความรูเกี่ยวกบัหลักการ ประเภทและคุณลกัษณะของ
ภาพกราฟกภาพกราฟก
2. สราง แกไข และตกแตงภาพโดยใชโปรแกรมสําเร็จรูปกราฟก
3. ประยุกตใชโปรแกรมกราฟกในงานอาชีพ



แผนผังหนวยการเรียน
. โปรแกรมกราฟก

2.โปรแกรมกราฟกสําหรับภาพ 1.หลักการ คุณสมบัติ ประเภท 7.โปรแกรมกราฟกสําหรับภาพ2.โปรแกรมกราฟกสําหรับภาพ
Raster 

3.ลักษณะและประโยชนAdobe 
Photoshop

4.เครื่องมือและการใชงาน
Adobe Photoshop

1.หลักการ คุณสมบัติ ประเภท
ของภาพกราฟก

7.โปรแกรมกราฟกสําหรับภาพ
Vector 

8.ลักษณะและประโยชน 
SketchUp Pro

9.เครื่องมือและการใชงาน
SketchUp Pro

5.พื้นฐานและทักษะ
Adobe Photoshop

6.ประยุกต/สรางสรรคงานดวย 
Adobe Photoshop

10.พื้นฐานและทักษะการใชงาน
SketchUp Pro

11.ประยุกต/สรางสรรคงานดวย 
SketchUp Pro



เน้ือหาในหนวยการเรียน
• การกําหนดหนวยวัดในชิ้นงาน

• Toolbar (แถบเครื่องมือ)

• Status Bar (แถบสถานะ)• Status Bar (แถบสถานะ)

• Measurements (แถบกําหนดขนาด)

• Drawing Area (พื้นทีก่ารทํางาน)

• Drawing Axes (แกนอางอิง)

• การวาดเสนการวาดเสน รูปราง รูปทรง

• การสรางโมเดลเรขาคณิต• การสรางโมเดลเรขาคณิต

• การสรางโมเดลอสิระ

• การสรางโมเดล 3 มิติ หรือการออกแบบผลิตภัณฑ



สมรรถนะประจําหนวย
1. มีทักษะวาด สราง แกไข รูปราง รูปทรง โมเดลดวย
โปรแกรม SketchUp Pro
2. มีทักษะในการออกแบบ และสรางโมเดลดวยโปรแกรม 2. มีทักษะในการออกแบบ และสรางโมเดลดวยโปรแกรม 
SketchUp Pro



ทบทวนเนื้อหา หนวยการเรียนรูที่ผานมา

1) การกําหนดหนวยวัดในชิ้นงาน คือ การกําหนดหนวยวัด ซึ่งประเทศไทยใช
หนวยวัดเปน เมตร เซนติเมตร เราควรเขาไปกําหนดหนวยวัดดังกลาว กอนการสราง
ชิ้นงานใดๆ โดยเลือก Window > Model Info แลวเลือก Format : Decimal ชิ้นงานใดๆ โดยเลือก Window > Model Info แลวเลือก Format : Decimal 
หนวยวัดที่ตองการใชเปน m 

         



ทบทวนเนื้อหา หนวยการเรียนรูที่ผานมา

2) Toolbar (แถบเครื่องมือ) เปนแถบรวบรวมเครื่องมือตางๆ ในการทํางานของ 
Sketchup เราสามารถเรียกแถบเครื่องมือกลุมตางๆ ไดจากเมนู View > Toolbars 
แลวเลือกแถบเครื่องมือที่ตองการ โดยแถบเครื่องมือที่แสดงอยูจะมีเครื่องหมายถูกแลวเลือกแถบเครื่องมือที่ตองการ โดยแถบเครื่องมือที่แสดงอยูจะมีเครื่องหมายถูก
อยูที่หนาคําสั่ง

         



ทบทวนเนื้อหา หนวยการเรียนรูที่ผานมา

3) Status Bar (แถบสถานะ) เปนแถบที่รายงานสถานนะกิจกรรมของเราใน
ขณะนั้นวากําลังใชเครื่องมือหรือทํากิจกรรมใดๆ กับโปรแกรม

  

4) Measurements (แถบกําหนดขนาด) เปนชองเล็กๆ ใชบอกขนาดและ
รายละเอียดของวัตถุที่เรากําลังทํางานอยู

 

5) Drawing Area (พื้นที่การทํางาน)



ทบทวนเนื้อหา หนวยการเรียนรูที่ผานมา

6) Drawing Axes (แกนอางอิง) คือเสนแกนสําหรับอางอิงการทํางานเพื่อใหการ
วาดรูปทรงและการสรางแบบจาํลองในทิศทางตางๆ เปนไปอยางถูกตองแมนยํา 
ไดแก   X จะอยูในแนวราบหรือแกนนอน (แกนสีแดง) ไดแก   X จะอยูในแนวราบหรือแกนนอน (แกนสีแดง) 

Y จะอยูในลักษณะของแนวลึก (แกนสีเขียว)

Z จะอยูในลักษณะของแนวตั้ง (แกนสีน้ําเงิน)

จุดตัดกันระหวางเสนแกนทั้ง 3 เสนเรียกวา Origin Point โดยตําแหนงของ Origin 
Point จะมีคา X,Y,Z เทากับ 0



1.การวาดเสนการวาดเสน รูปราง รูปทรง

เสน รูปราง และรูปทรงนั้นเปนพื้นฐานสําคญัของงานออกแบบและสราง
แบบจําลอง (Model) เพื่อใหไดชิ้นงานที่สมจริง สวยงามและนําไปใชไดจริง 

เสน คือ จุดเชื่อมระหวางจุด 2 จุด เสนเปนพื้นฐานในการสรางรูปรางในการ
ออกแบบ ประกอบดวย เสนตรง เสนโคง เสนอิสระ ซึ่งสามารถวาดเสนไดใน
แนวแกน X, Y และ Z และเสนทั้ง 3 ลักษณะ สงผลตอรูปราง รูปทรงในการ
ออกแบบเชนกนั
• เครื่องมือวาดเสนตรง ไดแก  (Line) • เครื่องมือวาดเสนตรง ไดแก  (Line) 
• เครื่องมือวาดเสนโคง ไดแก  (Arc)       (2 Point Arc)       (3 Point Arc) 
• เครื่องมือวาดเสนอิสระ ไดแก  (Freehand) 



1.การวาดเสนการวาดเสน รูปราง รูปทรง

รูปราง (Shape) หมายถึง เสนรอบนอก (Out Line) ของวัตถุที่เรามองเห็น ซึ่ง
เปนลักษณะ 2 มิติ มีความกวางและความยาว ไมมีความหนาหรือความลึก นําไปใช
ในงานออกแบบ 2 มิติ แบงออกเปน 3 ประเภท ดังนี้ในงานออกแบบ 2 มิติ แบงออกเปน 3 ประเภท ดังนี้
1) รูปรางธรรมชาติ (Natural Shape) 
หมายถึง รูปรางที่เกิดขึ้นเองตามธรรมชาติ 
เชน คน สัตวพืช เปนตน 
2) รูปรางเรขาคณิต (Geometrical Shape)
หมายถึง รูปรางที่มนุษยสรางขึ้น มีโครงสราง
แนนอน เชน วงกลม สามเหลี่ยม สี่เหลี่ยม แนนอน เชน วงกลม สามเหลี่ยม สี่เหลี่ยม 
เปนตน



1.การวาดเสนการวาดเสน รูปราง รูปทรง

3) รูปรางอิสระ (Free Shape) หรือเรียกอีกอยางวา Abstract Shape หมายถึง 
รูปรางที่ถูกเปลี่ยนแปลงใหงายขึ้น หรือตัดตอนใหผิดเพี้ยนจากความจริง อาจขยาย
ขึ้น ตัดทอน ดัดแปลง เพื่อใหเกิดความแปลกใหมขึ้น ตัดทอน ดัดแปลง เพื่อใหเกิดความแปลกใหม



1.การวาดเสนการวาดเสน รูปราง รูปทรง

     ในการออกแบบและสรางรูปรางใน Sketchup Pro สามารถทําไดโดยใช
เครื่องมือในกลุมวาด ดังนี้ 
• เครื่องมือสรางรูปรางเรขาคณิต ไดแก   • เครื่องมือสรางรูปรางเรขาคณิต ไดแก   
  (Rectangle)  ใชวาดรูปสี่เหลี่ยม
  (Rotate Rectangle) ใชวาดรูปสี่เหลี่ยม
  (Circle) ใชวาดรูปวงกลม
  (Polygon)  ใชวาดรูปหกเหลี่ยม
  (Pie) ใชวาดรูปเศษสวนของวงกลม 

การวาดรูปรางอาจใชเครื่องมือ Line และ Arc รวมกับการใชเครื่องมือกลุม การวาดรูปรางอาจใชเครื่องมือ Line และ Arc รวมกับการใชเครื่องมือกลุม 
Solid Tool ดวยก็ได การสรางรูปรางอิสระหรือธรรมชาติ เปนการประยุกตใช
เครื่องมือกลุม Rectangle, Circle, Polygon, Pie รวมกับ Freehand และ
เครื่องมือกลุม Solid Tool



1.การวาดเสนการวาดเสน รูปราง รูปทรง

รูปทรง (Form) หมายถึง ลักษณะของวัตถุที่เรามองเห็นเปน 3 มิติ คือ มีความ
กวาง ความยาว และความหนาหรือความลึก แบงออกเปน 3 ประเภท ดังนี้
1. รูปทรงจากธรรมชาติ (Natural Form) หมายถึง รูปทรงที่เกิดจากสิ่งมีชีวิตใน1. รูปทรงจากธรรมชาติ (Natural Form) หมายถึง รูปทรงที่เกิดจากสิ่งมีชีวิตใน
ธรรมชาต ิเชน คน สัตว พืช โดยการนํามาใชในงานออกแบบลักษณะ 3 มติิ 



1.การวาดเสนการวาดเสน รูปราง รูปทรง

2. รูปทรงเรขาคณิต (Geometrical Form) หมายถึง รูปทรงที่มนุษยสรางขึ้นดวย
เครื่องมือ ไดแก รูปทรงสามเหลี่ยม รูปทรงสีเ่หลี่ยม รูปทรงกลม เปนตน รปูทรง
เหลานี้จะแสดงความกวาง ความยาว และความหนาหรือความลึกมีปริมาตรหรือมวลเหลานี้จะแสดงความกวาง ความยาว และความหนาหรือความลึกมีปริมาตรหรือมวล



1.การวาดเสนการวาดเสน รูปราง รูปทรง

ความสมัพันธระหวางรูปเรขาคณิตสองมิตแิละสามมิติ
หลักในการออกแบบหรือสรางโมเดลใน Sketchup Pro  คือ การมองสิ่งของหรือ
ชิ้นงานตางๆ ออกเปน 2 มิติ และ 3 มิต ิดังนี้ชิ้นงานตางๆ ออกเปน 2 มิติ และ 3 มิต ิดังนี้



2.การสรางโมเดลเรขาคณิต 

   รูปทรงเรขาคณิต หรือโมเดลเรขาคณิต มักประกอบดวยเสน และรูปรางเรขา 
แลวเพิ่มมิติดานหนาหรือความลึกเขาไป ทําใหมองเห็นเปนภาพกราฟก 3 มิติ ซึ่ง
ใน Sketchup Pro สามารถสรางรูปทรงเรขาไดโดย ใชเครือ่งมือวาดรูปรางตามใน Sketchup Pro สามารถสรางรูปทรงเรขาไดโดย ใชเครือ่งมือวาดรูปรางตาม
แนวแกนที่ตองการ จากนั้นจึงใช Push and Pull เพิ่มมิติใหกับหนาของรูปราง
เรขาคณิตนั้น เชน
ขั้นที่ 1 ใช Rectangle วาดรูปสี่เหลี่ยมขนาด 2 เมตร x 3 เมตร
ขั้นที่ 2 ใช Push and Pull ดึงผิวหนาของรูปรางขึ้นมา



3.การสรางโมเดลอิสระ

   รูปทรงอิสระหรือโมเดลอิสระ มกัเปนการประยุกตใชเสนอิสระในการวาดรูปราง
ตามตองการ จากนั้นจึงเพิ่มมิติใหรูปรางนั้นกลายเปนรูปทรง ซึ่งใน Sketchup Pro 
สามารถทําไดดังนี้สามารถทําไดดังนี้
ขั้นที่ 1 วาดเสน หรือรูปรางอิสระดวย Freehand หรือ Line หรือ เครื่องมือในกลุม 
Drawing Tool ตามแนวระนาบที่ตองการ

     



3.การสรางโมเดลอิสระ

ขั้นที่ 2 ใช Push and Pull สรางมิติใหกับรูปราง



4.การสรางโมเดล3มิติ

   การออกแบบโมเดล 3 มิติ คือการประยุกตใชเครื่องมือ
หรือโปรแกรมกราฟกในงานออกแบบวัตถุหรือ
ชิ้นงานตางๆ ใหสามารถเห็นรูปลักษณะ มิติ ชิ้นงานตางๆ ใหสามารถเห็นรูปลักษณะ มิติ 
กายภาพ พื้นผิวและรายละเอียดที่เหมือนจริง
ดวยการจําลองแบบ 3 มิติ  (Simulation) 
กอนนําไปสรางหรือประดิษฐชิ้นงานขึ้นจริง 
ดวยความสามารถดานการออกแบบและ
สรางโมเดลจําลองที่มีประสิทธิภาพของ 
Sketchup Pro สามารถออกแบบและSketchup Pro สามารถออกแบบและ
สรางโมเดล 3 มิติ ไดดังนี้    
(ตัวอยาง การสรางโมเดลตูเสื้อผา)



4.การสรางโมเดล3มิติ

ขอกําหนด สรางตูเสื้อผา ขนาด กวาง 1.50 เมตร
 ลึก 0.6 เมตร สูง 1.60 เมตร ลายไม ประตูกระจกใส
ขั้นที่ 1 กําหนดไฟลออกแบบใหมีหนวยเปน เมตรโดย ขั้นที่ 1 กําหนดไฟลออกแบบใหมีหนวยเปน เมตรโดย 
เลือกเมนู Window > Model Info > Unit 
เลือก Format เปน Decimal และ m  Precision
เปน 0.00 m ดังภาพ
ขั้นที่ 2 เลือกใชมุมมอง Top View จากนั้น วาดรูปรางสี่เหลี่ยมผืนผาดวย Rectangle 
ขนาด 1.50 x 0.6 เมตร ในแนวระนาบ (เสนสีแดง)
 



4.การสรางโมเดล3มิติ

ขั้นที่ 3 เปลี่ยนมุมมองเปน Perspective 
ขั้นที่ 4 ใช Push and Pull ลากพื้นผิวของสี่เหลี่ยมใหมีปริมาตรในแนวต้ัง
(เสนสีน้ําเงิน)(เสนสีน้ําเงิน)



4.การสรางโมเดล3มิติ

ขั้นที่ 5 ใช Line วาดเสนตรงจากจุด
กึ่งกลางดานหนาบนลงลาง เพื่อแบงครึ่ง
บานประตูของตูบานประตูของตู
ขั้นที่ 6 ใช Offset ลากเสนกรอบขนานกับ
เสนของบานประตูของตูเขามา 0.10 เมตร 
(10 เซนติเมตร) ทั้ง 2 บาน (ซายและขวา) 
และวาดเสนขอบขนาด 0.03 เมตร (3 
เซนติเมตร)สําหรับสรางบานกระจกใส แลง
ดึงพื้นผิวของในออกมา 0.01 เมตร (1 ดึงพื้นผิวของในออกมา 0.01 เมตร (1 
เซนติเมตร)



4.การสรางโมเดล3มิติ

ขั้นที่ 7 ใช Tape วาดเสนกะระยะ
กึ่งกลางบนประตูตูในแนวนอน 
เพื่อสรางที่จับเปดบานประตตูู เพื่อสรางที่จับเปดบานประตตูู 
ขนาด 3 เซนติเมตร ดวย Circle 
ระหวางขอบประตูกับกรอบกระจก
ของตู ดานละ1 วง จากนั้นใช Push
and Pull ดึงปริมาตรออกมา 3 

เซนติเมตร
ขั้นที่ 8 ใช Tape วาดเสนกะระยะขั้นที่ 8 ใช Tape วาดเสนกะระยะ
บานประตูตู หางจากขอบตูดานหนา  0.03 เมตร (3 เซนติเมตร) จํานวน 3 ดาน
คือดานขางซาย-ขวาและดานบน



4.การสรางโมเดล3มิติ

ขั้นที่ 9 ใช Paint Bucket เพื่อใสสี ลวดลาย
และพื้นผิวใหกับตู โดยจะปรากฎ 
แถบ Default Tray ดานขางของจอภาพ แถบ Default Tray ดานขางของจอภาพ 
ใหเลือกแถบ Materials จะมี Drop Down 
List รายการวัสดุ พื้นผิว สี ใหเลือก 
ขั้นที่ 10 เลือกแถบ Wood (ลายไม)
คลิ้กเลือกลายไมที่ตองการ แลวนําไปคลิ้ก
พื้นผิวของตูทุกดานและตําแหนงที่ตองการ
ขั้นที่ 11 เลือกแถบ Glass and Mirrors เลือกพื้นผิวกระจกใส แลวคลิกที่ชองหนาขั้นที่ 11 เลือกแถบ Glass and Mirrors เลือกพื้นผิวกระจกใส แลวคลิกที่ชองหนา
ประตูของตู



4.การสรางโมเดล3มิติ

ขั้นที่ 12 ตรวจสอบรายละเอียดโมเดลทุกดาน หากพบขอผิดพลาดใหแกไขให
สมบูรณ



สิ่งที่ควรรู (Should Know & Could Know)

การใสสีสันและลวดลายใหโมเดลดวย Paint Bucket
1) การเลือกหมวดหมูของส/ีวัสด/ุพื้นผิว

   2) การใสสีสันลวดลายใหโมเดล   2) การใสสีสันลวดลายใหโมเดล
 
• การเลือกใชเครื่องมือกลุมมุมมอง (View) รวมกับ Orbit และ pan ทําใหการวาด 
การขึ้นรูปทรง ทําไดสะดวกรวดเร็ว และอยูในแนวแกนหรือระนาบที่ตองการ
• การวาด หรือแกไขรูปราง สามารถใชเครื่องมือ Tape และ Dimension ชวยในการ
กะระยะ เพิ่มความสะดวก แมนยํา ในการวาดยิ่งขึ้น



ใบงาน/กิจกรรมสรางทักษะ

จงออกแบบและสรางโมเดล 3 มิติ ดวยโปรแกรม Sketchup Pro ตามขอกําหนด
ตอไปนี้
                     ตูเสื้อผา                     ตูเสื้อผา
รายละเอียด
กวาง 1.20 เมตร ลึก 0.60 เมตร สูง 1.60 เมตร
ฐานของตู 0.10 เมตร
มีประตูเปด 2 บาน มีลิ้นชักเกบ็ของ 2 ชอง
ความสูง 0.15 เมตร ความกวาง 0.60 เมตร
• ตําแหนงลิ้นชักจะอยูดานเดียวกันหรือแยก• ตําแหนงลิ้นชักจะอยูดานเดียวกันหรือแยก
ซายขวาก็ได
• กําหนดพื้นผิว สีสัน ตามจินตนาการ



เกณฑการวัดผลและประเมินผล

1. พื้นฐานการใชโปรแกรมกราฟก

2. ทกัษะการใชงานโปรแกรมกราฟก

3. จิตพิสัย

เกณฑวัดผลงาน

 1. ขนาด สัดสวน และรูปทรงถูกตอง

 2. องคประกอบ/รายละเอียด ครบถวนสมบรูณ

 3. พื้นผิว /สีสนั /ความสวยงาม สมจริง 3. พื้นผิว /สีสนั /ความสวยงาม สมจริง



ถามตอบ/ใหคําปรึกษา
อยาลืม ! ตั้งคา หนวยวัด มาตรา กอนเริ่มงาน (Decimal / Mater)
1. การขึ้นรูปทรง จําเปนตองมีรูปรางกอนเสมอ 
2. การเปลี่ยนแปลงรูปทรง ทําไดดวยการแกไขเสนที่ประกอบรูปราง2. การเปลี่ยนแปลงรูปทรง ทําไดดวยการแกไขเสนที่ประกอบรูปราง
3. เสน รูปราง รูปทรง ทําใหเปนวัตถุดวยการ Make Group
4. วัตถุที่สมบูรณแลว เก็บไวใชในงานอื่นดวย Make Component



นําเสนอผลงาน/แนวคิดจากผลงาน
แนวคิด แรงบันดาลใจในการออกแบบ สรางสรรคงาน
การใชเครื่องมอืในโปรแกรมกราฟก
การเลือกใชองคประกอบในชิ้นงานการเลือกใชองคประกอบในชิ้นงาน
เทคนิค ขั้นตอนในการสรางสรรคงาน

(จากตัวแทนนกัเรียนที่สรางชิน้งานเสร็จสมบูรณกอน)



สรุปบทเรียน
การสรางโมเดล 3 มิติ
ความรู
     ความรูในการใชงานโปรแกรมกราฟก      ความรูในการใชงานโปรแกรมกราฟก 
ทักษะการใชงานโปรแกรมกราฟก 
    1. วาด สราง แกไข รูปราง รูปทรง โมเดลดวยโปรแกรม SketchUp Pro

2. สรางโมเดล 3 มิติ ดวยโปรแกรม SketchUp Pro
เจตคติและกิจนิสัยที่ 
   1. มีวินัย    1. มีวินัย 
   2. ใฝเรียนรู
   3. มุงมั่นในการทํางาน
   4. มีเจตคติและกิจนิสัยที่ดี


